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Introduction Bruker AXS

B EVA (short for Evaluation) is a program designed to provide the
customer a quick and easy way to process data

B Primary functions include
e Determining peak locations and FWHM

e Comparing scans against a database (Db) of known compounds and
determining the phases which are present

e Making a scan with respect to a known standard, typically the ICDD
Db file, to determine the lattice parameters and phase composition
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Layout of EVA S

(upper portion)

Bruker AXS

B Toolbox B Search/ Match

DB SR & R 2lcp Emnsm sl wmi5E e 84027 6)a] & 1]

. Zoom , Screen | “Y-unit Y-scale  Shts(Pst] | Cumentwl: | Scan: EEEE Nist 674a [Comundum.rav)
4 |1 Segment ~]| |27he!a_||30uﬂ13_||l-ma' >||Fieed  ~|| 15408Cu  |Pattem: I

B Magnified view 2]
of the cursor il =T
location | N Mt ———l —
B Set the Y scale to B This window
Counts or Counts shows the entire

per Second scan
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Layout of EVA S

. Bruker AXS
(lower portion)
B Main editing window >
B \Worksheet tabs MM
! s Ly
W Position of the cursor ‘Bj —
(COO rd i n ateS) » [IE-Theta 161,261, d:1.51188 ] - [ Counts : 277, Y% : 6.46 ]




Importing a Scan

1. Select New Worksheet —

2.Select Import a scan
(.raw file) button

3. Select a scan with a
mouse-click. To import
multiple scans, press the
[CtrI] key while clicking =~

4.Select Open \

|

BVEVA - [Doct 4]
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Bruker AXS

[ Fie Edt Vew Window Help

Look jn: | 3 Eva Tutorial

[ Corrundum.raw|

[

x|« ®ckEr

File name: Itwundum. raw

Files of type: | Scan Files [*.1aw)

DR @ SR 7] 2 2B B am| K|ad ol sk e] &by
Heunit it ‘-scale  She(Pat] | CumentwWl: | Scan: |
G dloes = | s patem: s
\ You can also open an
_ existing EVA document
< >
2 - T R
lmpoﬂStanﬁbs =
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Zooming on a Scan Range Bruker AXS
| | B el =
" To un-zoom, double G =
click in this window — | ﬁ ] |

® To adjust the maximum
intensity for the
zoomed range, double
click in this window

® To zoom-in on a peak,
use the mouse to draw
a box over the area of
interest -




Stri - K B(I;mn
rpping Aq: e
(Applicable to machines that do not have a monochromator) Bruker AXS

f/ 1. Select Toolbox
BELIGEEE ml&lﬁl@l PRSI IEmlv@I_I_II

Y ale SItPl

Current W/L: Scal -N ist 674a [Corrundum
1 5405 Cu F' iten

2. Highlight the scan

ToolBox

IS—F‘tt Peak | Label | Le

A

namns atk | En
] D—N st 674 corr... Lntkam 2. 7 /

3. Select Strip KA2

£ Eleld |dib < i

4. Use the slider to set the

correct ratio of Koz to Jmm - Append creates a new
Kaa (0.5 is the default e e | e scan with the background
ratio) — ‘;,M—“ il subtracted

- Append

u | | Replace applies the
background subtraction to
- 5. Select Append Jround s |

the current scan




Determining the FWHM and Position of
Peaks Using the Area Function

‘-scale Slits [Pat.

[2 The'ﬂ:l' :“Lm [Fued ]| 15«lusl:u Pattem: |

Scan : I Mist 674a [Conmundum.raw]

__ h

—
Scan | Pattem | Peak |[ Awea Label | Level |

_”I_IJI‘EEEJ U= o Eidi BlA|

+ Left Ink.
i ¥ D—mgm 13 046°  43.603°  3.08Cps
¥ []—Nisté74a  43.046°  43.603°  2.00Cp:

Selec: an Area

|2CIJ 571 'I?'l 423 | InaWindow
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Bruker AXS

Zoom in on a peak

Select the Area tab in
the Toolbox

Select Multi-Scans
Select Create

Using the mouse, drag
a region over the peak

If you are interested in a single
scan, highlight the scan of
interest in the Scan tab, then
select Area, and then select
Create



Determining the FWHM and Position of )
Peaks Using the Area Function (continued) pruer %8

oolBox | . .
e 6. Lines have been added to the window

) afufcxlnl @+ sl slal|

B 7= o o o ?EZ"SL} 7. Use the scrollbar to scroll to the right to view

— Nist 674a 43.046°  43.603° 2.09Cps age .

— [ — — these additional fields:

=

G

) FWHM - Full Width of the peak at Half Maximum <«

&

Q| Observed Maximum - Point with maximum intensity |
S e——— Al Chord Middle - Middle of the cord used to determine

the FWHM

E&

(e Bt | [l ™R | Seeemen Gravity Center - Weights the determination of the peak

|“3-““;Zt,_s|::f“’ﬁ | iz“ﬁﬁlpul‘;f | iy center using the intensity ®

Net Area — The area under the peak with background
subtraction taken into account. Used for IQOQ

Note that Gravity Center, Chord Mid and FWHM are
only valid for isolated peaks!
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Subtracting the Background e

. . Bruker AXS
In preparation for doing a Search / Match
Toulbon g
i [ Scan  Pallen | Pesk | Aea | Label | Level |
= 4m|@ x|m| @ D] & 2]Al
1. Highlight the red scan : %_‘f;."“;’;:"‘“‘ e
2. Set the threshold to 0 and % 5 O - T
move the slider until the red 3
background line fits the o)
background of the data igj
3. Select Append A 5
[~ Gray &l Except Curent  ltems Selected: 1 AN
4. Repeat steps 1-5 with the | Backond PeskSesch] Stpkaz | _Fouisr | _Smeoth |
#-Offset |Disp€acern.| ‘-Scale | Aberrant |ﬁdd..='8ubt|
bIaCk scan [V Sublract from Scan I” Enhanced MI
’»Ia "~ Cuvawe | P2 Roplace |
L o Theshod Append |

! “‘“W‘i‘w"F"U’f;'r_.rﬂ'n'-rm-l"_"--u-m"' | Nl g it M



Cleaning Up the Worksheet

1. Hide the “non
background subtracted
scans by double clickin
the checkbox

2. Highlight the pre-Kgq»

stripping scan

5. Set Max to ¥ the
intensity of the highest
peak and Min to 0. Then
using the slide translate
the scan vertically
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Bruker AXS

1

o

ToolBox

sl

Scan  Pattem | Peak | Aea | Label | Level |

J %@ x|m| B 2t &4

] Sample name ] File name | Scan Type | Start | En

[#) = Nist 674 Corr... Locke... Ziic Ts
E‘I— Nist 6742 Corr...  Llocke.. 2. 7.
IT - Nist 674a Corr... Locke... 2. 7.

_ Nist 6743 Corr...  Llocke.. 2 7

D
&

Q|

jo

£
™ Gray All Except Current  Items Selected: 1

Backand. | PeakSearch| Stip KA2 ier | Smooth |

#-0ffset | Displacem.

ize Append

L~

| Y-5cale Abeirant I Add./S
1000 Max 0| 2Lt
1 Value  Multiply ;
L — A

ot TS L R e ———_—

P

3. Select Y-Scale

4. Check the Add
circle

~

6. Select Replace

s sion s ot o




Smoothing the Scan

If the scan has an unacceptable amount of noise

3. Use the slider
to set the red

line on the

right side of

the bend

ToolBox )

Scan Pattein | Peak | Area | Label | Level |

= am(@ x|®| © 2| £33 BA

| Sample name I File name | Scan Type | Stark | En

>

i [ [#) == pist 6743 Corr... Locke. .. S 3
[ [#] = mist 674a Carr... Locke... 2. ‘

il [4] = nlist 6742 Gorr I Loc Ker B O )
[ [#] == mist 674a Carr.... Lacke... 2. 7.

ka

=]

2|

=]

Q)
Iil 11} i

I Gray Al Except Current  Items Selected: 1
Backand. | PeakSearch| StipKa2 [ Fouier _ Smooth
%Offset | Displacem. | Y:Scale | Abemant | Add./Subt. |

e 4 126998 [ |

\ e

T — ST S

1 I l Ii.:\ ] [\
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Bruker AXS

. Highlight the Scan

with Kq2 subtracted

. Select Fourier

(You could also try
Smooth but we have
gotten better results
with Fourier)

. Select Replace




Additional Toolbox Functions

Delete the highlighted scan \
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ToolBox I
Scan Pattern Peak I Area I Label | Leve' |
— | o,lo [ i
= wle|m x|m| & B =avls , Select which
Move the scan * |Sample name |File name |5can Type |Sta C(_)Iumns '.tO
up or down in 5 O M@=nisterda  Com.. lodke.. 2. display/hide
e [ [ [4] = nist 674a Cort... Lacke... Pt
\ a | O 8= nist 674a Corr... Locke... 5 x H
: == [ [#] == nist 674a Cott... Loct - e
f—1 pie At ” — | Col Selection 7
Varlous' i E-Nist 6?43 cnrr. S Loc .:V:::; Co!um:s' ‘ i Show the following columns - .
propertleS Of . g:lamnlename |:; Move Up |
the scan =t A Eer
\i_:b dth:
Change the / )
color of the Q
Save As Default| Fiestoe Defaull
sScan :




Peak Search

1. Ensure that the
background subtracted™ |
Kaz stripped scan is
highlighted

2. Select Peak Search

3. Adjust the Threshold
and Width until the peak
locations are satisfactory\
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Bruker AXS

ToolBox &Y
IW Pattern [ Peak | Area | Label | Level |
= a[n]@ x]e| © ) i FlAl
D O e [fepmm [amtze [ Make a DIF is used
¥ O[=—rnist674a  Cor.. Locke.. 2. tO Create a list of
i L
L T intensities
) Append to List is
B used to label the
o] peaks in a scan
Q)
(Gl B
Wpt Current  ltems Selected: 1 f_‘] A
Backand. Ilm Strip KAZ ] Fourier | Smoath |
%-Offset | Displacem. | Y-Scale | Abemant | Add/Subt. |
0208626 Max o 2| petaut| | 4. Select
7& 0188 Width Peaksfound: 10 Make DIF |I: Make DIF or
¢ [0006354 Min Thieshold[3 ~ AppendTalList | Append to List




Peak Search - Exporting the DIF

(Used to create custom patterns in a PDF Db)

@ EVA - [Corrundum *]
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Bruker AXS

[B. File  Edi view window Help

I - oot o] a5 | 8| s[ @[B4 [ 1]
Clone, .. ﬁ Current WL: Scan: I Nist 674a (¢
b cave Ctrlts T 1| 1.5406Cu |Pattern : I DIF Nist 67 .
Save As... 1 1- Ensure the DIF IS
Save As Current FPM Model - - -
-] highlighted in the
o | e santesa s || Toolbox: Pattern
Close Chrl+w B E o . d
E  Pprint... Chrl+P Current Pattern as DIF file — winaow
Print Preview ) = as MetaFile
Page & Printer Setup... i /
Print All Documents m—
1 Corrundum ToolBox I
2 0711-061 Scan Im Peak | Area | Labe, Level |
32-13-07 ME ,2 mm CAP NIST674a LynxEve 20-71 contigffus2 % ﬂ i) 1‘ @ iz %5 §_J] @‘ él
. 4" | S5-WY\-PPPP | Compound Nai Formula ] ¥-Scal
2. Select File > Export > 5 Do o Nste7a | Corn. | B
Current DIF Pattern — 2
=l
B
2
<5
Q
[(_'l' il m




Peak Search - Append to List Bruker AXS

. Zoom 4 Screen Heunit Y-unit Y-seale  Slits(Pat] | Cumentwl: Scan : I Nist 674a [Comundum.raw)
— I‘ISegmenl LI |2-ThetaL”Cps LI Linear 'l Fired || 1540500 ENle e i
wi ToolBox =
Scan | Fattern II Peak Area | Label | Level |
ﬁ :E & | I ‘Wark on reference patterns_IB g ﬂl B @l Al
T Caption | Legend | Angle | d value | Intensit
4 | copton [Logend | |
Eil 0 ~ W Sy — d=... 3.  25.  3h2Cps &0 L
4 FAfh—ld=. 3.  23. 158Cps
— W Sy = 4., 20, 40.8Cps
Vv - 5. 17. 18.3Cps
] By =, 5. 16 34.8 Cps @
-
3 El ] Sy =, S. 15. 1.04Cps 2
e ]
ey QI W] Sy = 6.. 15.  2.96Cps i
&4 M Sy — d=.. 6. L. 13.70ps ¥
Y & W = =, 6.  13.. 205Cps

Append to List prints the Q
peak positions on the Graph il | )

Items Selected: 10 _’\'] £

The default setup is to label T

i - i dvalue IW Drag & Drap & new Peak g
th e pe a kS W I t h d S p a CI n g S e I—BB.‘I o o to a suitable position E‘r

Intensity |2D.4983 |3 ® sigma 'l Drop Selection on Scan |

i
=
b

238270

-l o=
+
140547
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Changing the Default Peak Label B(;'.Zﬁ)xs

To change the default labels to Angle, Intensity:

: a1 1. Select View>
(Semngs... ZaS i
| | | | ..J Settings, then the
Levels & Maximums Decimal Places Progtam Defaults FPM Miscellaneous =
Databases | XRF | Draw Sizes | Colrs | AutomaticPiot | Sl Te
.| pix. [02 mm| [02 mm |@ 4 2. Change the text box
Pattern % | V in the Peaks category
(=l px[04 mm) from d=9%62 to
T %1, %3
[z e [3 om fot,%
| =4
Label
=18 px|5  mm |bla bla...
| e =4




Changing the Default Peak Label Bruker AXS

3. Highlight the old peaks and select X to delete them

4. Redo the peak
search on the scan o R

J— |1 Segment;l

tab and select =

Append to List

Current WwiL:
1.5406 Cu

Mist B7 4a [Corundum. raw)]

FH-unit r'-unit ‘r-scale Slits [Pat.
|2-ThetaL||Eps LI ILinear] Fixed =

LE
I Peak Arga I Label I Level I

ToolBox

Scan Pal
_Sean_|

= | ¥|w|m x|m w2 B A
M L ‘!‘ ICaption ILegend IAngIe Idvalue IIntensit I
(P | —— P | O, . W=z 2. 34.. 2280Cps |-
2 k] b W = 35.... 3. 25.. 32Cps
4 M8y—a7. 3.  23.. 15.8Cps E
g T =43, 4.. 2.0.. 40ECps
o ¥ v Hy—s2..., 5. 1.7.. 18.3Cps
& W 84— 57.... 5.  16. 3480ps
=] EI W G — 53, 5.. 15. 1.39Cps
5 Ql W &y—61..., 6. 15. 2960Cps
¥ W Gy 6.... 6. 1l4. 13.7Cps
5 W 8= 68.... 6. 1.3.. 20.5Cps
Q
(= I | (2]
i ment  Items Selected: 10 () £

255147 228 Cps

o

I Edit Make DIF I Mormalize |
d value |1.3?484 Drag & Drop a new Peak
to a suitable position
Angle |88.1B23 Fller
Intenzity |2D.4953 |3 ¥ sigrma VI Cirop Selection on Scan |

]
i

37723°, 158 Cps
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Changing Individual Peak Properties Bruker AXS
ToolBox B8
1. Highlight the peak Scan | Pattem [ Pesk  Area | Label | Level |
E #®@ x|m ®a 2livii 2A

2. Select Properties

+ | Caption [Egend | Angle | dvalue | Intensity |

P v =25, g o i Cps

V] Gy 35.... 8¢ 25.. 34.2Cps

PS V] By 37.... 3.. 2.3.. 15.8Cps

= V&= 43.... 4.. 2.0.. 40.8Cps

V| V-2, 5.. 17.. 18.3Cps

V] By 57.... .. 16.. 34.8Cps

| V- ..., 5.. 15. 1.04Cps

D V] By 61.... 6... 1.5.. 2.96Cps

— V] g5.... 6. 1.4.. 13.7Cps

'573‘ V] SRy 8.... 6... 13.. 20.5Cps

(Peak Properties: Single Selection 1

Title = 25,526 *, 22.8 Cps [~ Legend 12
%12 | [N

fBT;LI;;'I FJ rﬂ ID Ornientation [ﬁ— {
Angle Caption Size (pixels) I 2 Peak (T
rﬁ?ﬁ Caption Size (mm) I_S— sition
Intensit

22.7893 Cancel | OK ‘lm oh Scan |
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Setting the Database Location B(;'.Zﬁ)xs

1. Open the Settings Palette: Select View > Settings...

@, File Edit Wiew ‘Window Help

D |8 | | 5ettingsen BB B M| N[ Sl i[5 @] o005 E)atBs]4| &Kl
i oolbox 2
;earch.n’rnatch Ei Y-unit Y-scale  Shts(Pat) | CumentWLl: | Scan: |
2. Select the Database . Soomeeo sy o=t = fm o
o Searc name or # FS
t b rsor coordinates  Fé
a # Settings F? r-Seltim_r,s.. ' '
- Residual Scanmode  F9 Levels & Maximums Decimal Places Program Defaults FPM Miscellaneous
3' Type a tltle for the Cross hair F10 Databases | >]<FIF | Draw I | GB;izes | Clolms | ]AutomaticP!ol |
Title: File: P~
Mas_ter Datab?]se and B s e iz P> Master Database |MASTER| |C:\DPRD\PDF2005.4C4 |
navigate to the PDF User Database | | =
Db (Usually located in e y sp“Ee;*EaTZ‘BE}} } —
C:\ PDF or C:\DPRD) sy e | 2
ysbom sty Specialized Database (4) =
4. Repeat if the user has San muiaie aipus RIR Fie [CAOIFFPLUS\Eva IR |
a CUStOm user Db {501y palter tskg ™ Use 1 for Unknown I/lc
[ ok | cancel |




e )
BRUKER

Opening the Search/ Match Windows Bruker AXS

1. Open the Search/ Match window 2. Open the Search Results window

# 0| 9k(@zm A &li]

|| B S]m] el

skl = E e

- Zoom 4 Screen Heunit *Y-unit ‘ecae  Slts Pat) rent WS Scan: I Corrundum (Comundun.raw)
JCwnts J IL\near _] IFmed ;I gscu L |
[#]
=
L
0 | \ ( '
(] I [>] '“-—M"—-’-'—"J"«‘WMW" - . J IL“—'J“—‘-_'
2 ) P 4@ 0 50 ]
ToolBox & 'Search/Match o Search Results &
[ Scan Pattem | Feak | srea Latel | Level | JCrRerbon: < Subfiles = IU_ 2 4heta offsel 5SVVV-PFPP | Compound Name | Fommula | Mic | nd | FOM | I
2= 2 Neutral > | | Inorganic v .
Q ﬁl% [ﬁ_]J is| E‘ J_|_| _IJ — Duality Marks—— | Draanic [ Displacement
s | saraple name | File name | Scan Type | Start | En N B D g%‘a*d I.g
= (O EI— Corrundum COMTa Locke. . o 7. |2 i o ] ner 1 d multiphied by
~ [ [#]= Corrundum Corr... Lucke.‘. 2. 7s Disola st lﬁp« AT
ﬂ O [# = corrundum Cotr... Lacke... 2. 7. 4”’] %lasal L Exp. +3tuet. 7 R e
= [#) = [Carrindim Gorr... Locke... 2 7 - Cherrical Fiter-
T D e
Li|Bel BlC|H|O|F |Nel
all e Mg FIEIEEEI
g K |CalSe| Ti|V | Cr|Mn Fe|Co| Ni|Cu| Zn| GalGe| As{ Se| Br| Kr|
Rb| St| ¥ | Ze|na| M| Te| Rul Rh| Pe Ag| Ca| In|Sn|Sh| Te| 1 [e]
& CsBa) La] | Talw | Re] 05| r | Pt Au Hg| T Pl 6 o ]
Q| Fr sl 2] <] i INEY
[~ Lanthanides Ce| Pr|Nel| Pm|Sm{ Eu| G T Dy|Ho| Er| Tm| ¥ Lu| Diag & Drop the selection in a window
[~ Toggedll  Th| Pal U | Mp| Pulsmi Cn| Bl Cf| Es| Fm| Md] Mo| Ln] — Staistir:s
[< ] w [’J = Search On: Scan: Conundum [Cormundur. raw)
— . . L d multiphied by : 1.
1 Z2theta offset: 0.000
[~ Gray All Except Curent  ltems Selected: 1 0y £ =)  Scen W [Corundum (Cormurdum.raw] Displlzz:rms:l: 0.
. - 2theta window :
Backgrd. | PeakSearch| Stipk#2 ||~ Fourer Smooth — Patten ] Criterion : 2 Neutial
%Dffset | Displacem. | Y-Scale | Abenant | add./Subt. | — stng [=] - . gatab%se: ]c;?;%@mml-‘zuuaqm
i otal nurmber :
—F 20 1B Main Database Man Results: Match Chem./Subfile - 74333
- [MasTER = _FElinate duplicates [[45 = “Malohing Intensity - 74220
__FPeplace | I~ add User Database to search Insert in Curent Document [V Elapsed Time: 0.5
Append
Read ] Save | Default | XRF | Filter | | Search Read Save Fieset List
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Search/ Match Window Bruker AXS
Criterion: Search/Match *
e Favor Simple Patterns - Criterion -~ Sulbiles i Ztheta offget

Patterns with the least 2. Meutral R4 Inorganic v PR o e
matching peaks — Quality Marks grgel'”": II; ' R
Lia
= Neutral - Usual Setting; no VOLUDDOD s | e
preference FEEFE T D R e
e Favor Complex Patterns - Display az a list | IE:-:I:._ + Stuct, ;I Iv Skip Mon &mbiert
Pattems with the most |—Ehemin:a| Filter |
matching peaks

Subfiles: Which subdatabases _
should be included B Experimental/ Structural

e Experimental: ICDD patterns

Quallty Marks e Structure: Patterns calculated from the

= Yellow are the most reliable structure Db
= Red indicates the pattern is ) _
missing some information O Sklp Non Ambient - Skip patterns where

the measurement was not carried out at

e Grey are not reliable
room temperature / pressure



B(I;mli
Search/ Match Window (>

. Bruker AXS
(continued)
— Chemical Filter
B Chemical Filter - Click the H(D| He|
element to change its color Li|Be B|IC|N|O|F |Ne|
- Red = not present Na| Mg AllSi|P S| clAr

K |Calse] Ti| V | Cr|Mn Fe|Col Ni| Cul Zn| Gal Ge! As| Se| Br| Kr|

e Grey = might be present
Rb! Sr| Y | Zr| Nb| Mol Te|RulRh| Pal Agf Cal In| Sn| Sb| Te| 1 ||

- Green = must be present Cs|Bal Lal H| Talw |Re] Os| Ir | Pt| &ulHo| Ti| P B Po) At Rn|
= Toggle all will change all of Fr!Ral Ac
the elements’ colors I~ Lartherices el PNl Pm S| Eul Gaf Th Dy Hol Er| T YHi Lui
B Scan [ ToggleAll  ThiPal U |Np! PulAmCrmi Bk Cf| Es|Fimi Mcl No| Ln
e The scan which will be
searched =)  Scan MW |Corundum (Corundumn.raw)

—/ Pattem 1|

B Eliminate Duplicates

—/  Shi v
- If 2 patterns had the exact T t"'"g T
S T
positions, it will eliminate St chpleces =
them from the results I© add User Database to search Insert in Current Document [v
Read I Save | Default #RF | Filter I Search
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Performing a Search/ Match Bms

1. Highlight the last scan on the list. This scan had the background

subtracted, Kq» stripped, and Fourier smoothing applied
\

e ———— ‘ — oy i
[ Sean Pattern | Pesk | drea | YLabel Level | ]Z'm:z:al = I:::;f:‘::c = [0 24heta offset
= ﬂ%%&% EEE‘ =3} ¥ 5_"' E‘ﬂ —ﬁualitylv'larks Oiganic [ | |2 Prplagoment
4 | sample name | File name | ScanYvpe | Start | En £ S Ty Op D 6 aydd g
\i' [ [$)= Corrundum Corr.., Locke 2., 7. FEMOCTT et I'l d multiphed by
| OO oo todey 2. 7| [Zmwwas]  [emrsee SR siramion) 2 Input the
EI [ —|Cermindim Cotre. locke. Y 20. 7 B m”em'“ic;l”t‘“ - . t tt
&3 =3
Li|Bel BlC|NIO|F el IR Il SEHINte=
@l MIfﬂ_gi | Ti| % | Cr| Mn] Fe| Cof Ni| Cuf I%EIH@EE}EIMI
K |Ca|Se| Ti|V | Cr|hn| Fe| Col M| Cu| Zn Ge| Az Se| Br| Kr A
Ql Ria| St | ¥ | Zr|Mb| Mo] Te|Ru| Rh| Pd| AglCd| In| Sn|Sh| Te| 1 | el 3. If a User database IS
& Cs|Ba| Lal Hf | Ta| vy | Re| O3] Ir | Pt] & Hg| T1| Ph| Ei| Po| &t |Rn =
al Sl Tl sl L Al B AR L™ hragent, check this
[~ Lanthanides €&l Pr|Nd|Pm|Sm Eul Gd| Th| Dy|Ha| Er[T Tu
I ToaoeAl  Th{ el Nl PulArf B o Es{SaMiNo|Ln box
(Sl (2]
[ Gray &l Except Current  Items Selected: 1 LY =y s I |Carrundum (Corm
e o 4. Select Search
Backond. | PeskSearch| Stinka2 |[™ Fourier Smooth_| — Pattem |
¥Offset | Displacern. | Y-Scale | Aberant | Add./Subt | —/  Sting -
—_— I— m' M ain Datab, bdax Results:
2_Jid [M = _Elminate duplcates [[43 =
ﬁ I~ ‘add User Database to search Insett in Curent Document v
Append
Read | Save | Defaut | xAF | Fiier |[ Seaen




gD
BRUKER
(<)

Search / Match Results Bruker AXS

B Results are displayed in the Search Results window and the
Toolbox: Pattern window

e e e s | —— = e e . b . The Figure of Merit
_ o [ " EEE—— " (FOM) column gives

Scan |[ Paltem  Peak | Aea | Label | Level | Critetion Subfiles = [0 2theta oifset $SAMV-PPPP | CompoundName | Formuia | Mic | nM | FOM A/ a rou | ea o ow
| o T 2 Neutral | | Incrganic |7 : Z)01081-1667 Alminum Oxide  AROZ 12 0 036 gh d f h
= lem|@ x|s| B8 2l 2|4 QualiyMarks 3'9"'”“: :; 11 Diclacamart 2301.070-5679 Corundum ARO3 12 0 037
D | ss-vwv-ppPP_| Compound Name | Formula | v=[~ P) DD 5000461212 Corundum, 5 4203 13 0 050

: Mineral ¥ . - g
_@I W D= [01-081-1667 Aluminum Oxide  Al203 40 o ] i 1 dmultiplied by L;000M0-0173 Comndum,spn  AR203 13 0 076 We t e atte rn

0D 01-0893072  Corundum, syn  Al203 91 = . I301-083-3072  Corundum, syn A0z 8 1] 117
D list Eup. + Stuct. v | ¥ Skip Non Ambient

o B'® 000542447 4Benzoypy..  C19.. 10| wdaﬂy“: LA prenam 000542447 4Benzoplppridi..  C19H.. 42 4 198 matCheS The Iower
T D 0004158 N{(4Methox., .. 10 ’Chz"WZ' L - 000421084 N{dMethowp.. C1H.. 38 0 204 -
¥ H® 000651952 ovanlyiden.. 3. 6 “C—_ o 000451952 oVanillidens.. C9HL. 46 4 217

0% 00055009 CesumChron G2 3 " — Il Ef Y e 000550095 Cesum Chomi. Cs20r. 5 3 230 the nun |ber , the
Bl 8D wosizz0 Cobstgam.  Cl0.. 6 T:'hcm}s T e ot i AR C'r:" 000542200 Cobalbgamma.. CIH.. 47 6 233
a S r e Co| Ni|Cu d s
& @® 000531890  alphaPotass..  CaHKO4 3 ! e K 000331840 dphaPolassiu.  C4HK. 46 2 235 b h h
2 H® 000551194 SodumSme.. C3.. 4 ah S il 2l NS ok e, i Sl i 0 e T X odum5meth. CH3. 44 3 243 etter t e n |atC
gl B ®  00-012-0847  Adppic acid ... 4 Cs|Bal Laj H| Tal\W | Re| 0wt | AwlHgl T1| Pb| Bi| Pol At Rn| nlnnm-mn . T -..=I"
Q| I® oSS Wdipt. 0. S (] 51 SR ] _ & L [2]
M€ 00-040-1556  p-Toluic acid C8HEO2 1. FLanthanizdes Eﬂ%M%%%E%ﬂEL’"ﬂ% Drag & Drop the selection in a window o o .
S P Toagle &l Th|Pa| U [Np| Pul &miCm| BK| C| Es| Fm| Md Nol Ln - Statish : H hl h
ID Y 000512539 LArgninedi..  C6..  44¥ 2= S Search On : Scar: Cormundum (Cortundum.aw) . I g I tl n a
3] PR 2 d muliplied by - 1.
) 21heta offset : 0,000
I~ Gray All Except Current  Items Selected: 1 () A&, =) Scan M [Comundum [Conrurrdum.lav.w] Displacement: 0. patte rn ShOWS the
Y-Scale dxBy | Wavelength| Ture Cell | Make Peaks| — Pallem W |01-081-1667 Aluminum Dside (41203) Z-Ihetaatr:.n Neubal
hkiGen. | FPM Model | FPMEval | Residue —s sung [*] - Database : C:\DPRDAPDF2005.4C4 I 1 1 h
| | o | e | ~ s o L S ines in the scan
l += [a076 Mak%  Fine Tuning | Set To 100% [asten ][ cnate dopkcatss l“a—._" Malch Crem /Sublle 74333
= | atching Intensity : -
T = |03 Actual % SetTo [lAut :l' [T add User Database tojsearch Insett in Current Document Elapsed Time : 4. WI n d OW
<= [a.01 Min %
Read | Save | Defaut | ®AF | Fie |[ Seach I By|  Asad | Save | DeleteSelecion| Resetlis
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Displaying the PDF for a Pattern Bms

ToolBox X
Scan | Im Peak | Ares | Label | Lewel |
= almlm x| @ 0 =i A

| 33-Y"Y-PPPP | Compound Marne | Formula | \"-:[A

=

‘i’l W I)m 01-081-1667  Aluminum Oxide Al20E 40
[T} 01-089-3072  Corundum, syn Al20s a1 =
B Select the PDF Database 4 %) 00-054-2447  4-Benzoylpy..  C19.. 1D
o — ['I) 00-042-1884  M-(4-Methox..  C13.. 10
bUtton to view the PDF + [0 = 00-045-1952  o-Vanilyliden... 9. G,
=} o00-055-009  Cesium Chro.., 52, 3
El Iy  00-054-2200  Cobalt-gam... 0. 6
\.Ebl [ ®  00-033-1840  alpha-Patass..  C4HKO4 30
[ ®)  00-055-1194  Sodium S5-me.., 3. 4.
Ql O #  oo-012-0847  Adipic acid Ch... 4.
Ql [ ®)  00-055-1715 N -{4-Dip-t... C30... 5.
[Ty o0-040-1556 p-Taluic acid CaHa02 1,
0 ®  00-051-2339  L-Arginine di.., ... 4.|[V]
[( ] I | [ }]
[ Gray &l Except Curent Items Selected: 1 E] N

-Scale | dx By | Wavelengthl Tune Cell | Make Peaksl

hkHGen |[FPM Model FPMEval | Residue |

bl el Fittieg lirmits:;

Reset | S |
I.Eu:urrunu:lum j Fit F'aram.l [Create |




Refining Lattice Parameters

Bruker AXS
TC-)OcljbOX. Scan — Scan Pattern |
winaow — ,
El ;d%l%l %_} ToolBox
2_ CheCk the bOX neXt # Samnle Scan IPatlem Peak | Area ] Label | Level |
. S L] [4] == | 2 2vil8
to the original scan =iy _E’;ﬁ: Al @ x(m| @ & ={aaf ] FA
2 B 3 — | S5-YWY-PPPP | Compound MName | Formula | Y-:[I_\J
SO It IS nOt hldden "‘I - EI Carrun HIn |01-081-1667  Aluminum Oxide  AI203 40
| P 01-089-3072  Corundum, syn Al203 91| =
5 H X} 00-054-2447  4-Benzoylpy... C19.., 10 |
3. Return to the Toolbox: Pattern window IR ® woims Miveon.  Cin i
4. Highlight the pattern that fits the scan R ® 00065152 ovenlldden.., 9. 6.
0 *) 00-055-0096 Cesium Chro... Cs2... 3
the best /EJ I @ 00-054-2200 Cobalt-gam...  C10.. 6
= O =}  00-033-1840 alpha-Potass... C4HKO4 3
5. Se|eCt the PrOpertles button and CheCk Ql O =}  00-055-1194  Sodium S-me. .. i 4.
the FPM boxes ﬁ' O *)  o0-012-0347 Adipic acid Ch..., 4,
g' B % 00-055-1715 N -{4-Di(pt...  C30... 5.
[JCy 00-040-1556  p-Toluic acid C8HBOZ 1.
O ®  00-051-2339  L-Argninedi..  Cé6... fl_.1|l]
Ii| 1 [ m
™ Gray 8l Except Current  Items Selected: 1 ]j] B
Y-Scale | dx By |'w'ave!englh[ Tune Cell IMake Peaksl
hkl-Gen. |[FPMModel FPMEval | Residue |




Lattice Parameter Refinement

(continued) Bruker AXS

[0 *) 00-055-0096 Cesium Chra.. Csz... 3

El 0T 000542200 Cobalt-gam... C10... 6.

g [0 *) 000331840 alpha-Potass...  C4HKO4 3.

[ *} 00-055-1194  Sodium S-me...  C3... 4.

@ ] :} 00-012-0847  Adipic acid Cé... 4,

Q| @®  00-055-1715 N -(4-Dilp-t... C30... 5.
6. Select FPM_MOd_eI_ —I ey  00-040-1556  p-Toluic acid CBHBOZ 1,
(FPM Model is refining [ %) 000512339 L-Argninedi.  Co.. 4%

a single phase, and FPM flm | >
Gray &ll Except Current  Items Selected: 1 _fi] P

Eval. is for quantitatively

refining a mixture Y-5¢ dx By |Wavelength| Tune Cell |Make Peaks|

hk-Gen. |[FPM Model FPMEval | Residue |
7. Select the original scan file \ Model fiting lits:

Reset | Show |

I.Enlrundum v | Fit F’aram.l Create |

8. Select Fit Param, and the Model Parameters dialog will
pop-up

9. In Model Parameters make sure none of the Fixed
boxes are checked and select OK




Lattice Parameter Refinement Result Bruker AXS

FPM Fit results

. Mumber of steps: 20 ~
B R/RO is a measure Of e |R/RO: 1.22 €= )
. . RiwWP: 5.97
the flt, lisa perfeCt Delta displacement: -0.083 mm
01-081-1667 Aluminum Oxide
R/RO
--------------------- Al203
. Pw/HM(30): 0.0851
n ApprOXImate CryStal —— | Crustaliite Size (Scherrer): 956.0 == 4
. . System: Rhombo.H.axes
(g ram) Slze Space group: R-3c (167)
Cell param.: Initial Final
i . a: 4.76000 4.75976
B Refined lattice il B 12.99300 12.39385]

parameters

You need to hit the [Create] button in the tool to save this Fit result as a new
MODEL scan.
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